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IntroductionAlarmPoint for BMC Performance Manager Portal
1. Introduction
This document describes how to install and configure the AlarmPoint® for BMC® Performance Manager Portal integration. 
The intended audience for this document is experienced BMC consultants and other system administrators.

1.1 Summary
This integration supports Event notifications (from BMC PMP to AlarmPoint) through BMC PMP notification rules. You 
will need to modify this configuration to suit your particular business requirements and adjust it to suit your expected loads. 
This example features extensive logging in AlarmPoint; in a high-volume production system, this can significantly affect 
performance. Consider your expected volume of alerts and server capacity when designing your own integration with 
AlarmPoint. 

1.1.1 Overview
The basic steps of the integration process are as follows:

1. Install the AlarmPoint Java Client on the BMC PMP system.

2. Configure the integration between AlarmPoint and BMC PMP:

• Configure the Portal system to send events to AlarmPoint.

• Configure the Portal system to send user notifications to AlarmPoint.

• Configure the Portal system to send enterprise-wide notifications to AlarmPoint.

3. Configure AlarmPoint for the BMC PMP Event Domain.

4. Validate the integration by triggering a notification and returning a response.

1.2 Benefits
With the AlarmPoint integration, the appropriate technician can be notified directly via voice, email, pager, BlackBerry, or 
other device, and information about the event is presented to the recipient. 

The benefit is that this process is immediate – significantly faster than the time required for operations staff to notice the 
failures or malfunctions, determine who is on call, and manually notify the right person. During the process, every 
notification, response, and action is logged in AlarmPoint.

The AlarmPoint product features a self-service web user interface to allow accurate assignment of responsible personnel for 
each job. AlarmPoint also includes an enhanced Subscription panel that allows both managed and self subscription to BMC 
PMP events.

1.3 System Requirements
The following products are used in this integration:

• BMC Performance Manager Portal 2.5.00

• AlarmPoint 3.2.1 (patch 004 or later)

• AlarmPoint Java Client 3.2.1
Summary   |  1
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1.3.1 Supported Operating Systems
This integration supports the following operating systems:

• Microsoft® Windows 2003 (validated)

• HP-UX

• Solaris 10 (SunOS 5.10 validated)

• AIX

• Linux

1.4 Conventions & Terminology

1.4.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu, 
and then click the Open menu option.

Words in bold typically reference text that appears on the screen.

Words in monospace font represent the following:

• text that must be typed into the computer

• directory and file names

The directory in which you install the AlarmPoint application is referred to as <APHOME>. On Windows, the default 
location of <APHOME> is C:\Program Files\AlarmPointSystems\AlarmPoint. On Unix, the default installation 
folder is /opt/alarmpointsystems/alarmpoint.

The directory in which you install the AlarmPoint Java Client is referred to as <APJC>. On Windows, the default location of 
<APJC> is C:\APAgent. On Unix, the default installation folder is /opt/alarmpointsystems/apagent.

Note: Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must 
substitute the given paths with the Unix equivalents.

1.4.2 Terminology
With respect to this integration, the following definitions apply:

With respect to the AlarmPoint System, the following definitions apply:

Term Meaning

Notification Rule Item of interest detected by BMC Performance Manager Portal

Event One or more items associated with an alarm

Term Meaning

AlarmPoint Admin Administrative tool to control AlarmPoint Agent
Conventions & Terminology   |  2
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AlarmPoint Agent Communication layer between third-party applications (e.g., a Management System) 
and AlarmPoint Server

AlarmPoint Client The Management System uses this to communicate with the AlarmPoint Agent

AlarmPoint Application 
Server Node

The core AlarmPoint application, consisting of various components that process 
events and perform notifications.

AlarmPoint Java Client Umbrella term for the AlarmPoint Admin, AlarmPoint Agent, and the AlarmPoint 
Client (both Java and native versions)

AlarmPoint Notification 
Server Node

Delivers notifications to a user in a variety of ways (pager, phone, e-mail, etc.)

AlarmPoint System Umbrella term for all AlarmPoint software components

AlarmPoint Web User 
Interface

Browser-accessible interface for controlling AlarmPoint components and information.

Management System A synonym for BMC Performance Manager Portal

Term Meaning
Conventions & Terminology   |  3
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2. Installation
This chapter provides information about installing the AlarmPoint for BMC Performance Manager Portal integration.

2.1 Installing the AlarmPoint System
This integrations requires the following AlarmPoint applications:

• AlarmPoint

• AlarmPoint Java Client

2.1.1 AlarmPoint
Consult the AlarmPoint Installation and Administration Guide for details.

2.1.2 AlarmPoint Java Client
Install the AlarmPoint Java Client on the BMC Performance Manager Portal system. During installation, set the address of 
the AlarmPoint server.

For complete installation instructions, refer to the AlarmPoint Java Client Guide.

2.2 Installing BMC Performance Manager Portal
Consult the BMC Performance Manager Portal user guides for installation details.

2.3 Installing the Integration
This section covers the installation steps required for the integration components.

2.3.1 Extracting the Executable
Extract the AP-BMC-PerformanceManagerPortal archive to access the integration files. The following shows the notable 
files and folders (bold) in the archive:

.
|--components
| |--alarmpoint
| | |-- scripts
| | | ‘-- AP-BMC-PMP.aps
| | |-- sub_panel
| | | ‘-- BMCPMPSubscriptionForm.jsp
| | ‘-- vox
| |   ‘--english 
|--documentation
| |-- SampleRequest.xml
| ‘-- AP-BMC-PMP.pdf
|-- release-notes.txt
‘-- version.properties 
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3. Configuration
Before using the integration, you must configure the following components:

• BMC Performance Manager Portal

• AlarmPoint Java Client

• AlarmPoint

This section explains the configuration processes required.

3.1 Configuring BMC Performance Manager Portal
To configure BMC PMP, you must configure Portal to send events, user notifications, and enterprise-wide notifications to 
AlarmPoint.

3.1.1 Configuring Portal to send events to AlarmPoint
1. Log on to BMC Performance Manager Portal as the Portal administrator (superadmin).

2. Click the Portal tab.

3. On the Global Properties page, under AlarmPoint Settings, specify the following configuration properties:

• AlarmPoint Host: host name for the APAgent.

• Port: port for the APAgent (usually 2010).

• Client ID: bmc_pmp

4. Click Next until the Finished page is displayed, and then click Finish.

3.1.2 Configuring Portal to send user notifications to AlarmPoint
1. Log on as a user (or, from the Accounts tab, impersonate a user), and select the Configure tab.

2. Under Tasks, click Notifications, and then click Manage Rules.

3. Click Add.

4. On the Properties page, type the notification rule name in Rule name, select Status Change Violations, and then click 
Next.

5. On the Send page, select the notifications to send to the AlarmPoint server, and click Next.

Note: For AlarmPoint notifications, Portal does not send a notification when the status of an object returns to OK.

6. Select a notification type, and then click Next.

7. On the Notify Objects page, select the objects to which the notification options apply, and then click Next.

8. On the Notify Options page, select the time to wait after an event before sending notification.

9. Under Notify on Object Type Using, select AlarmPoint, then click Next.

10. On the AlarmPoint page, specify the following AlarmPoint settings, and then click Next: 

• Action Script Set: BMC_PMP
Configuring BMC Performance Manager Portal   |  5
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• Person or Group ID: AlarmPoint User ID or Group ID to notify. (This entry must correspond to an existing User 
ID or Group ID in AlarmPoint.)

11. On the Finish page, click Finish to save the notification rule and return to the Notification Rules page

3.1.3 Configuring Portal to send enterprise-wide notifications to AlarmPoint
1. While logged on as an administrator, click the Provider tab.

2. Under Tasks, click Notifications, and then click Manage Rules.

3. On the Notification Rules page, click Add.

4. On the Notification Properties page, type the notification rule name in Rule name, select Status Change Violations, 
and then click Next.

5. On the Send page, select the notifications to send to the AlarmPoint server, and then click Next. 

Note: For AlarmPoint notifications, Portal does not send a notification when the status of an object returns to OK.

6. On the Notify Options page, select the time to wait after an event before sending notification.

7. Under Notify on Object Type Using, select AlarmPoint, and then click Next.

8. On the AlarmPoint page, specify the following AlarmPoint settings, and click Next: 

• Action Script Set: BMC_PMP

• Person or Group ID: AlarmPoint Person ID or Group ID to notify. (This entry must correspond to an existing 
Person ID or Group ID in AlarmPoint.)

9. On the Finish page, click Finish to save the notification rule and return to the Notification Rules page.

3.2 Configuring the AlarmPoint Java Client
To configure the AlarmPoint Java Client, you must modify the APAgent.xml file to listen for requests on the IP address 
where the APAgent is installed. In the following instructions, <APJC> refers to the location in which you installed the 
AlarmPoint Java Client.

To edit the APAgent.xml file:

1. On the server where the AlarmPoint Java client is installed, locate the following file:

<APJC>\etc\APAgent.xml

2. In the APAgent.xml file, locate the following line:

<http port="2010" \>

3. Edit the line as follows, replacing $IP_Address$ with the IP address of the machine where the Java Client is 
installed:

<http port="2010">
  <socket-listener host="$IPAddress$" />
</http>

4. Save the file, and then restart the AlarmPoint Java Client.
Configuring the AlarmPoint Java Client   |  6
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3.3 Configuring AlarmPoint
Configuring AlarmPoint requires the following steps: 

• Import the AlarmPoint script package.

• Install the voice files.

• Define an Event Domain.

• Configure the default recipient (set up a target Group which contains a User with a text phone).

• Configure the Subscription Panel and create a fail-safe Group (optional)

3.3.1 Import the AlarmPoint script package
This step requires the AlarmPoint Developer IDE.

To import the AlarmPoint Script Package:

1. Launch the IDE, and configure the database connection (refer to the AlarmPoint Developer IDE Help or the 
AlarmPoint Developer’s Guide & Scripting Reference for details)

2. Click Workspace > Import.

3. Select the AP-BMC-PMP.aps file extracted from the integration archive file at:

..\components\alarmpoint\scripts\

4. In the File dialog box, click Open, and then click OK.

5. Right-click the BMC Performance Manager Portal (Business) folder, and then click Validate.

6. Click Close.

7. Right-click the BMC Performance Manager Portal (Business) folder, and then click Check In.

8. In the Check In dialog box, click Create.

9. In the Script Package dialog box, click Close.

10. Close the IDE.

3.3.2 Install Voice Files
These files must be installed into an AlarmPoint deployment running a Voice Device Engine. For more information, refer to 
the AlarmPoint Installation and Administration Guide.

To install the voice files:

1. Copy all of the files in the \components\alarmpoint\vox\english folder from the extracted integration archive 
to the following node installs folder:

..\node\phone-engine\Datastore\domains\common\recordings\english\phrases

Note: This integration provides only English voice files. 

3.3.3 Define an Event Domain
By default, this integration is set up to use the Event Domain, “bmc_pmp”; it is strongly recommended that you use this 
Event Domain. 
Configuring AlarmPoint   |  7
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For the integration to be successful, the Event Domain must match the Client ID of the AlarmPoint Java Client.

Note: The AlarmPoint Webserver must be running to perform this portion of the integration.

To define an Event Domain:

1. Login to AlarmPoint as a Company Administrator, and click the Developer tab.

2. On the Event Domains page, click Add New.

3. Enter the following information into the form:

• Name: bmc_pmp

• Description: BMC Performance Manager Portal

• Script Package: BMC Performance Manager Portal

4. Click Save.

3.3.4 Configure the default recipient
The integration is configured to directly target recipients as defined by the message group of the injected BMC Performance 
Manager Portal notification rule. To configure directly targeted notifications for injected notification rules, you must create 
an AlarmPoint User or Group associated with the targeted recipient. 

To configure the default recipient, confirm that the Operations Group exists in AlarmPoint, and that it has a single Team 
member: the default demonstration User, “bsmith”. Follow the steps below to ensure the User exists, is assigned to the 
“Operations Group”, and has a virtual text phone Device.

To set up a two-way Device:

1. In the AlarmPoint Web User Interface, click the Users tab.

2. On the Find Users page, click S. 

3. In the list of returned Users, click Smith, Bob.

4. On the Details for Bob Smith page, in the Common Tasks pane, click User Devices.

5. Verify that a virtual text phone Device exists.

6. Click Reorder, and set the virtual phone to be the first Device in the list.

7. Click Save.

8. Click the Details for Bob Smith link at the top of the page.

9. In the Common Tasks pane, click Groups User Belongs To.

10. Confirm that Bob Smith is assigned to the Operations Group.

11. Log out of AlarmPoint.

Note: If this user is missing, or is not assigned to the Operations Group, create a user with a User ID of “bsmith”, assign 
him to the Operations Group, and add a virtual text phone Device to the User. For more information and 
instructions on how to perform these tasks, refer to the AlarmPoint User Guide.
Configuring AlarmPoint   |  8



ConfigurationAlarmPoint for BMC Performance Manager Portal
3.3.5 Configure the Subscription Panel
To allow Users to subscribe to specific criteria on injected Events, you must configure the Subscription panel. (Note that in 
the following steps, <APHOME> refers to the location in which you installed the AlarmPoint application.)

To configure the Subscription Panel:

1. Copy all of the files in the components\alarmpoint\sub_panel folder from the extracted integration archive to 
the following folder:

<APHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\bmc-pmp

Note: It is recommended that you restart the AlarmPoint Webserver daemon after copying the files.

2. Log in to AlarmPoint as an Administrator and click the Developer tab.

3. On the Event Domains page, click the bmc_pmp Event Domain.

4. Add the following predicates to the Event Domain:

5. After you have added and saved the predicates, click Subscription Domains in the menu on the left side of the screen.

6. On the Subscription Domains page, click Add New, and then select bmc_pmp in the Event Domain drop-down list 
and click Continue.

7. On the Subscription Domain details page, create a Subscription Domain named BMC PMP, and enter the following 
path for the Custom Panel URL:

jsp\subscription\bmc-pmp\BMCPMPSubscriptionForm.jsp

8. Use the following guidelines for the remainder of the Subscription domain settings:

• For the Type of Management, select Both. This will allow you to assign the Subscription to Users, and to create a 
self-managed Subscription.

• On the Select Appropriate Predicates page, add all of the predicates listed above.

• When configuring Subscription response choices, note the default response choices included in the integration 
package. For more information, see “Response Choices” on page 17.

Predicate Type Important Values

metropolis_managed_object_status List Yes • Blackout
• Critical
• Offline
• OK
• Unknown
• Warning

metropolis_managed_object_name Text

metroplois_managed_object_type Text

metropolis_originating_cause_description_concise Text
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3.3.6 Creating a Subscription
You can now use the Custom Subscription Panel to subscribe to BMC Performance Manager Portal notification rules of 
specific severities, or that match any specified criteria. 

To create a Subscription:

1. On the Alerts tab of the AlarmPoint Web User Interface, click Assign Alerts.

2. In the Subscription type drop-down list, select BMC PMP.

3. Click the Add New link.

4. On the Subscription Details page, specify a name for the Subscription, and set the Subscription criteria using the 
Managed Object, Preferences, and Assign tabs.

• The Managed Object tab (Ctrl-click to select more than one node):

• The Preferences tab:
Configuring AlarmPoint   |  10
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• The Assign tab:

5. When you are satisfied with the criteria, click Save to create the Subscription.

• You can review the Subscription details at any time on the Summary tab:

3.3.6.1 Testing the Subscription Panel
To test the Subscription Panel, create a User in AlarmPoint and assign them a Subscription that matches the parameters 
injected from the BMC Performance Manager Portal when executing the Test Integration section. You can use the following 
criteria to match against:

• metropolis_managed_object_status: Critical

• metropolis_managed_object_name: AlarmPoint Test

• metropolis_managed_object_type: Test

If the parameters of an injected message match the Subscription criteria, AlarmPoint sends a Subscription notification to the 
configured User.

Note: Ensure that Subscriptions are enabled within the Action Script Package. For more information, see “FYI and 
Subscription Notification Variables” on page 19.

3.3.6.2 Create a Fail-Safe Group
If a notification is submitted to AlarmPoint when the fail-safe functionality is enabled, and if it matches the necessary 
circumstances, AlarmPoint sends the notification to the fail-safe recipient. The fail-safe recipient is typically a Group, but 
can be configured as a User.

To create a fail-safe Group:

1. Login to AlarmPoint as a Company Administrator, and click the Groups tab.

2. Create a new Group named BMC-PMP-Failsafe, with at least one User as a Team member to receive notifications.

For more information about creating Groups and Teams, see the AlarmPoint User Guide.
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Note: If you want to use a pre-existing group or a different group name, modify the value for the $fail_safe_group 
variable defined in the Initial Business script in the AlarmPoint Action Scripts.
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4. Software Component Integration
It is recommended that you start the applications in the following order:

1. BMC Performance Manager Portal

2. AlarmPoint Application and Notification Servers

3. AlarmPoint Agent

Consult the respective user manuals for details on starting these applications.

4.1 Trigger a Notification
This section describes how to inject a test notification into AlarmPoint using the JavaClient’s web user interface:

1. Using a web browser, navigate to http://<Java Client Host>:2010

2. In the menu, select HTTP API Demo.

3. In the extracted integration archive, open the documentation/SampleRequest.xml fle, and copy its contents into 
the HTTP Post Message field.

4. Click Do Post.

5. The default user (bsmith) should receive a notification (and, if configured, the Subscription should be triggered).

4.2 Responding to a Notification
This section describes how to respond to a notification using the default User’s virtual BlackBerry:

1. When a message arrives for the default User, the virtual BlackBerry appears and indicates the waiting notification:

2. Select the message to view its details:
Trigger a Notification   |  13



Software Component IntegrationAlarmPoint for BMC Performance Manager Portal
3. Scroll down using the arrow buttons to view the entire message and the list of possible replies: 

4. Select Acknowledge and send the reply:
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• The response is sent to AlarmPoint, which stops notifications to other Devices, and prevents further escalation to 
other Users:
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5. Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the AlarmPoint for BMC 
Performance Manager Portal integration.

5.1 Adding Extra Parameters To Notification Content
By default, all of the BMC PMP notification parameters are injected into the AlarmPoint event. The following steps explain 
how to add the metropolis_managed_object_previous_status parameter to email notifications; adding content for other 
Device types is similar and requires the presentation script to be modified for the specific Devices. 

To add extra parameters to email notification content: 

1. Open the AlarmPoint Developer IDE and checkout the BMC Performance Manger Portal (BUSINESS) Script 
Package. 

2. In the Presentation Action Script, add the following line to the email content creation section: 

$content.message = $content.message & "Previous State:" & 
$event.metropolis_managed_object_previous_status & "\n" 

3. You can also add a check in the Initial script to confirm that the custom parameter was injected properly and therefore 
exists within the Action Scripts: 

IF ( ! EXISTS( $event.metropolis_managed_object_previous_status ) )
  $event.metropolis_managed_object_previous_status = $undefined_default
  IF ( $main.debug )
    @script::log( $main.log_prepend & "Optional token ' 
metropolis_managed_object_previous_status' not found, defaulting to '" & 
$event.metropolis_managed_object_previous_status & "'" )
  ENDIF
ENDIF

Your custom parameter should now be injected to AlarmPoint with every BMC PM Portal message and appear in your 
notification content for Email. 

Note: This example affects only the content of normal notifications. To display this content in Subscription Notifications, 
update the subscriptionPresentation script accordingly. 

5.1.1 Using Custom Parameters for FYI Notifications
FYI notifications are informational only; they are delivered to recipients with no expectation that the recipients will act upon 
the notification. Regular, or non-FYI, notifications are delivered to recipients with an expectation that the recipients will act 
upon the event.

There are several ways to control FYI notifications; different types of notifications can be treated as FYI by using flags in the 
AlarmPoint Action Script. The following three types of flags control this type of FYI notification:

• $force_fyi: This flag can force notifications to be FYI (“on”), force them not to be FYI despite other settings (“off”), 
or it can be set to have no effect on whether notifications are FYI (“disable”). The default setting is disable.

• $subscription_fyi: This flag makes subscriptions be delivered as FYI notifications, so long as this flag is not 
overridden by the $force_fyi setting. Default setting is true.

• $fail_safe_fyi: This flag makes notifications sent to the fail safe group by FYI only. Default is true.
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Using flags in the Action Scripts, you can also control which devices are used for FYI notifications. For more information, 
see “Configuration Variable Reference” on page 19.

You can also configure BMC PM Portal so that only certain types of messages are sent FYI. 

To generate FYI notifications from AlarmPoint that are specific to a particular type of message in BMC PM Portal, a custom 
parameter must be added to a message template to instruct the integration to deliver the notifications as FYI. Add a custom 
parameter called “fyi” with a value of “true” to the template that you want to be delivered as FYI.

5.2 Response Choices
The AlarmPoint Integration allows recipients to respond to notifications with several default choices, some of which are 
injected back to the Operations Manager server, updating the original event.  Users notified on email devices also have the 
ability to respond with an extra annotation message which will be logged in the original Operations Manager event.  

The following is a list of the default response choices available with the AlarmPoint Integration and their associated actions 
on the AlarmPoint event and the Operations Manager event:

5.2.1 Changing and Adding Response Choices
You can change the response choices available within the presentation script (Subscription Responses are configured while 
setting up the Subscription Domain; consult the AlarmPoint Installation and Administration Guide for more information). 
The behavior of responses can be configured in the response business script in the Action Script set. 

As an example, the following code illustrates the Acknowledge response and all its components:

AlarmPoint Action Scripts:

• Presentation script:

  $content.choices = "Acknowledge"
  $content.choices::add( "Clear" )

• Response script:

# Handle responses
$reply = $response.reply

Table 5-1. Default Response Choices

Response 
Choice AlarmPoint Action Default Device Availability

Acknowledge Delinks everyone except the responding User, 
not allowing them to submit responses. The 
responder will not be notified further, but has the 
ability to affect the event by responding on one 
of their Devices or from the browser. 

All non-FYI Devices. For email, BES,and 
browsers, the response is called Acknowledge. 
For other non-FYI mobile Devices an 
Acknowledge is represented as an Ack.

Clear Delinks the responding User. All non-FYI Devices. For email, BES,and 
browsers, the response is called Clear. For other 
non-FYI mobile Devices a Clear is represented as 
an Cle.

Ignore The responder will not be notified further, and is 
not allowed to submit further responses.

All non-FYI Devices. For email, BES and 
browsers, the response is Ignore. For other non-
FYI mobile Devices an Ignore is represented as 
an Ign.
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$reply::toLowerCase()
$acknowledge= $reply::startsWith( "acknowledge" )

IF ( $acknowledge )
  @event::delinkAllExcept( $target_id )
  @event::delivered( $target_id )

  $message_note = "Acknowledged by " & $target_name
  IF ( $main.debug )
    @script::log( $main.log_prepend & $message_note )
  ENDIF
ENDIF

Note: This is only a brief overview of the required components, For more information about AlarmPoint responses and 
scripting, refer to the AlarmPoint Action Scripts and the AlarmPoint Developers Guide & Scripting Reference.
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6. Configuration Variable Reference
This section outlines and describes the configuration variables available in the initial Action Script.

6.1 Local Configuration Variables
These variables are available only in this script, and control how the script runs. For more information about the initial 
process script, consult the AlarmPoint Developer’s Guide & Scripting Reference

6.1.1 FYI and Subscription Notification Variables
The following variables configure the behavior of informational-only, or FYI, notifications. The value assigned to each 
variable is the default value within the script

Note: For more information on the behavior associated with informational-only notifications, see “Using Custom 
Parameters for FYI Notifications” on page 16.

Variable Description

$force_fyi = “disable” Forces notifications to be informational only rather than requiring 
responses. Possible values are:

• disable: nothing is forced.

• on: notifications are forced to be FYI.

• off: notifications are forced not to be FYI.

$use_email_for_fyi = true

$use_phone_for_fyi = false

$use_im_for_fyi = true

$use_text_phone_for_fyi = true

$use_text_pager_for_fyi = true

$use_numeric_pager_for_fyi = true

$use_bes_for_fyi = true

$use_generic_for_fyi = true

Configure Device filters for informational-only (FYI) notifications. 

Setting these flags to false prevents that Device type from being notified 
with informational (FYI) messages.

$enable_subs = true Enables Subscription functionality.  If set to true, Users subscribed to 
criteria matching the event will be notified. If set to false, no subscribed 
Users will be notified even if they match the criteria of the event.
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6.1.2 Fail-safe Configuration Variables
The following variables configure the fail-safe functionality, and specify when notifications will be sent to the fail-safe 
recipient. The value assigned to each variable is its default value within the script.

Note: For instructions on how to set up a fail-safe recipient, see “Create a Fail-Safe Group” on page 11. 

6.1.3 Alert Configuration Variables
The following variables configure Alert behavior. The value assigned to each variable is its default value within the script.   

$subscription_fyi = false Forces Subscription notifications to be informational only; recipients of a 
Subscription notification will not be able to respond to the event.

Note: If the $use_phone_for_fyi flag is set to true, a User can respond 
with “delete”, which removes the notification from the phone queue, “save”, 
which moves to the next notification without deleting, or “repeat”, which 
replays the notification.

The $force_fyi flag also forces subscriptions to be informational only. If  
both the $force_fyi flag and the $subscription_fyi flag are set to 
false, AlarmPoint will use the FYI flag submitted with the event from the 
Management System. 

Variable Description

$fail_safe = “enabled” Controls whether the fail-safe recipient is notified, and under which 
circumstances. Possible values are:

• enabled: notify the fail-safe Group if no Subscriptions match and 
there are no notifiable recipients.

• for-subscriptions: notify if the Subscription functionality is 
enabled and no Subscriptions match.

• for-recipients: notify if there are no notifiable recipients.

• disabled: disable the fail-safe functionality; no notifications will 
be sent to the fail-safe recipient.

$fail_safe_group = "BMC-PMP-Failsafe" Identifies the fail-safe recipient, which is typically a Group, but may be a 
User.

$fail_safe_fyi = true  Makes notifications to the fail-safe group informational only; recipients 
of a fail-safe notification will not be able to respond to the event.
The $force_fyi flag also forces fail-safe notifications to be informational 
only.

Variable Description

$override_timeframes = false Overrides any Device Timeframes that have been configured for a User for this 
notification.  

Variable Description
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6.2 Global Configuration Variables
These variables are available throughout the script package, and are parameters of the “main” object. The value assigned to 
each variable is its default value within the script.

$use_emergency_devices = false Forces the use of emergency Devices as part of the Device resolution processing. 

$track_delivery = true Configures the notification to run a response script when the delivery of a 
notification is successful. As this can limit Node performance, you can set this 
value to false if the custom behavior for successful delivery events is unnecessary, 
but you will lose any information about whether a delivery was successful. 

Variable Description

$main.timeout = 86400 Amount of time (in seconds) the event is allowed to run before 
timing out. (86400 seconds = 24 hours.) 

$main.debug = false Indicates whether to log informational messages for debugging 
purposes. Disabling this variable may improve performance, but 
will provide less information.

$main.use_logFile = false Specify whether to use an alternate log file for debugging 
messages. This variable is ignored unless $main.debug is also 
set to true.

$main.logFile = “../logs/BMC_ PMP_Script.log” Defines the file used to log debugging information (only if 
$main.use_logfile is set to true).

$main.maxInvalidResponses = 3 Specifies the maximum number of invalid responses allowed 
before the notification will no longer be requeued. If a recipient 
sends an invalid response and this number has not been 
exceeded, they will be renotified with the same content, prefixed 
with a message indicating that their response was invalid.

$main.enable_HTML_Email = true Enables HTML email functionality for email clients able to 
support HTML emails. If a client cannot support HTML than the 
plain text version will be passed.

$AlarmPoint_URL = "http://localhost:8888" Identifies the AlarmPoint URL used for the HTML response 
form and AlarmPoint logo. If the specified URL cannot be 
reached, the logo will not appear, and the response links will not 
work. 

$main.HTML_form_url = $AlarmPoint_URL & 
"/jsp/ProcessNotificationResponse.jsp"

Specifies the URL of the AlarmPoint Web Server’s Process 
Notification Response JSP form, used by HTML email and BES 
to inject responses through the system.

$main.use_logo = true Specifies whether HTML email notifications will display the 
AlarmPoint (or custom) logo.

$main.logo = $AlarmPoint_URL & "/static/
images/logos/alarmpoint/UNKNOWN.gif"

Specifies the path to the graphic displayed on HTML (email and 
BES) notifications.

Variable Description
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$main.logo_alt_text = “[If the logo does not appear 
you may be blocking images or you may be outside 
a firewall. If the latter, the links will not work for 
responding and you should respond by replying to 
this email as described below.]”

The alternate text to display if the HTML email logo is 
unavailable.

Note: If the logo does not display, it is unlikely that the 
HTML_form_url will work.

$main.numeric_pager_number = “555-1212” The phone number to display for calling in to retrieve event 
information. This variable has a non-existent number as a 
default value; a real call-in number must be supplied, or a 
message indicating that an AlarmPoint event notification has 
occurred.

$main.bes_pushurl = “http://localhost:8888/static” Specifies the URL of the BES server. (Optional.)

Variable Description
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7. Contact Us
You can access the AlarmPoint Systems Web Site at http://www.alarmpoint.com. From this site you can obtain information 
about the Company, the Products, Support and other helpful information. You may also access the Customer Support Site 
from the main web page. In this protected site you will find current product releases, helpful hints, patches, release notes, a 
helpful product knowledge base, trouble ticket submission areas and other helpful tools provided by AlarmPoint Systems, 
Inc. 

AlarmPoint Systems, Inc.

4457 Willow Road, Suite 220
Pleasanton, CA 94588
Phone: 925-226-0300 
Fax: 925-226-0310

Email: support@alarmpoint.com
Website: http://www.alarmpoint.com 

Hewlett-Packard Company

3000 Hanover Street
Palo Alto, CA 94304-1185 USA
Phone: 650-857-1501
Fax: 650-857-5518

Support: http://support.openview.hp.com
Website: http://www.openview.hp.com
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8. Copyright
AlarmPoint Systems, Inc. and BMC Software produced this integration document to assist customers with joint BMC/
AlarmPoint Systems implementations. BMC and AlarmPoint Systems have made every effort to ensure that the information 
contained in this document is accurate, but do not guarantee any accuracy now or in the future. AlarmPoint Systems™ and 
AlarmPoint® are a trademark and registered trademark, respectively, of AlarmPoint Systems, Inc. in the United States, 
United Kingdom and other jurisdictions. BMC Performance Manager Portal is a registered trademark of BMC Software. All 
other trademarks are the property of their respective owners.

©ALARMPOINT SYSTEMS 2009. Rights to reproduce this document only by written permission of ALARMPOINT 
SYSTEMS.
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